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1 Introduction 

Grant applications for development support from the MEDIA Programme must be made electronically 

using the eForm, and this online submission is considered to be the master copy. Applicants must also 

send 1 paper copy by post (as part of the application package).  

Please note: the application package for the paper copy has additional annexes (that are not part of the 

online submission). Please ensure that your paper copy includes all requested documents. For details 

of these, please follow the relevant links from the Project development webpage: 

      http://ec.europa.eu/culture/media/programme/producer/develop/index_en.htm 

The purpose of this document is to provide guidance on the technical aspects of completing and 

submitting the eForm. It does not replace the Guidelines which must be read and consulted by 

applicants for all guidance on the content of the application form, the application procedure and the 

rules that must be respected. The Guidelines for each Action can also be found by following the 

relevant links from the Project development webpage cited above. 

Please note that the terms 'eForm', 'form', 'application form' and 'online application form' are used 

interchangeably throughout this guide. 

You are strongly advised not to leave the preparation and submission of your application form until 

the last days before the deadline for applications 

 

Please read all of this User Guide before beginning your application 

2 Technical Requirements & Considerations 

The application form is an interactive PDF form that requires Adobe Reader software to be installed 

on your computer for you to be able to complete and submit it.  

The retrieval and submission of the form are ‘online’ activities but completion of the form and its 

validation are ‘offline’ activities. This is explained in more detail in the process overview below.  

Adobe Reader 

The minimum version i.e. lowest version of Adobe Reader that you must have installed on your 

computer is version 8.1.5. You may also use a higher version than this e.g. 8.2, 9.0, 9.1, X etc. If you 

have a lower version than 8.1.5, you will not be able to complete and submit the eForm. 

Follow the link below to be directed to Adobe's website to download the software free of charge or to 

upgrade your existing copy of the software. If you do not have administrator rights on your computer 

this activity may require the intervention of your IT department. You will need to specify your 

operating system before the download can commence. 

http://get.adobe.com/reader/otherversions/ 

If you are using Adobe Acrobat (Standard) or Adobe Acrobat Professional, the version must likewise 

be 8.1.5 or higher. 

The screenshots in this User Guide are based on version 8.1.5 of Adobe Reader. 

  

http://ec.europa.eu/culture/media/programme/producer/develop/index_en.htm
http://get.adobe.com/reader/otherversions/
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You can check the system requirements for Adobe Reader – i.e. the minimum required specification of 

your computer – through the following link: 

http://www.adobe.com/uk/products/reader/systemreqs/ 

Security settings in some versions of Adobe Reader and Adobe Acrobat 

If you are using a version of Adobe Reader or Adobe Acrobat that incorporates Enhanced Security, it 

is possible that the enhanced security settings will block the submission of your eForm. The involved 

versions of Adobe Reader and Adobe Acrobat are: 

 8.2 or any higher version 8 than this (including any sub-versions e.g. 8.2.1, 8.2.2 etc); 

 9.3 or any higher version 9 than this (and including any sub-versions e.g. 9.3.1, 9.4.2 etc; 

 any version X (including any sub-versions e.g. 10.0.1) 

The disabling of the Enhanced Security is performed from the following Adobe Reader menu path: 

 Edit > Preferences > Security (Enhanced) 

Uncheck the box Enable Enhanced Security and click OK. Once the submission has been performed 

you can re-enable the Enhanced Security. For more detailed instructions (including screenshots),  

please refer to the relevant 'Known Issue' on the following webpage: 

http://eacea.ec.europa.eu/eforms/index_en.php#issues 

Here you will also find instructions on how to leave Enhanced Security enabled but identify your 

eForm as a trusted item so that its submission is not blocked. 

 

Internet Connection & Browser software 

You will require an internet connection and standard browser software to retrieve and submit the 

online application form. 

Test eForm 

A test eForm is available on the EACEA eForm home page: 

http://eacea.ec.europa.eu/eforms/index_en.php 

The form contains a small number of questions and functions. It has been designed to help applicants 

understand how the main fields in the eForm work and also to ensure that their own software and 

internet connection allow an application form to be submitted. It is NOT mandatory to use this form; it 

is provided as a help tool for applicants who are using electronic submission for the first time. 

Advice for Macintosh Users 

The eForm can only be opened and completed using Adobe Reader or one of the Adobe Acrobat 

products. It is not possible to open and work with the eForm using the Mac Preview viewer. 

Please therefore ensure that if your default viewer is set as Mac Preview, you nonetheless open the 

eForm with one of the Adobe products mentioned above. This advice applies to both the download of 

the form – if you try to open it before downloading – and to the opening of the form for its general 

completion and submission. For more detailed advice, please visit the ‘Known Issues’ section of the 

EACEA eForm home page: 

 http://eacea.ec.europa.eu/eforms/index_en.php#issues 

http://www.adobe.com/uk/products/reader/systemreqs/
http://eacea.ec.europa.eu/eforms/index_en.php#issues
http://eacea.ec.europa.eu/eforms/index_en.php
http://eacea.ec.europa.eu/eforms/index_en.php#issues
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3 The Online Application Process – Overview 

(i) You download the eForm from the agency website, saving it to your own computer or local 

network drive. Do not try to fill in the form directly on the website. The form can only be 

filled in once you have saved it to your local computing environment. 

(ii) You complete the eForm on your own computer. You do not need to be connected to the 

internet for this and no connection to the EACEA website or any Commission server is 

required. Completion of the form includes the attachment of the annexes. 

(iii) You validate the form (on your own computer) to ensure that it is ready for submission.  

(iv) You connect to the internet and press the submit button to submit your form. You do not need 

to be connected to the EACEA website or to any particular webpage – this connection to the 

Agency server happens automatically. (The submission process includes a mandatory save 

both before and after the submission. These save operations are instigated by the form itself. 

This is explained in detail in section 8.)  

(v) If the submission is successful, a submission number will be automatically generated and 

added to your form.  

(vi) You print your form. 

(vii) An email acknowledging receipt of your form is automatically sent to the email address that 

you entered for the contact person of the Applicant Organisation (Part A.2).  

4 Working with the eForm 

4.1 Download the eForm from EACEA 

A link to a read-only copy of the form can be found on the on the EACEA eForm home page:  

http://eacea.ec.europa.eu/eforms/index_en.php 

Save the form to your local computer or network drive. You may give it a filename of your own 

choosing. 

You can now open, edit, save, close, print etc the file in the same way you would any other document 

you had saved or created on your own computer. 

4.2 Adobe Acrobat Reader – a brief introduction to some key features of the pdf form 

 

 

 

 

 

 

Attach facility  

DO NOT USE! 

The eForm has its 

own attach facility 

Activate  

Page Thumbnails 

(see below) 

Navigation panel, 

on the left-hand 

side of the screen 

Adobe Help for 

common features 

Activate the 

Highlight Fields 

facility 

VERY 

USEFUL! 

http://eacea.ec.europa.eu/eforms/index_en.php


  [Version 1] 

 Page 6 of 22  

Toolbar 

From the Tools menu you can customise your toolbar e.g. you can add the Save button if it is not 

already displayed. There are also various display and navigation options that you can add. 

 

 

 

Explained here are some of the commonly used display and navigation options: 

 

 

 

 

 

 

Customise 

toolbar 

selection 

menu 

(partial view) 

Zoom In 

(reduce 

image size)  

Zoom Out 

(enlarge 

image size)  

Fit form to 

width of screen 

and scroll across 

page boundaries 

Turn on ‘Page 

View’ – 

 1 whole page 

displayed  at a 

time  

Move 

back 1 

page  

Toolbar 

Move 

forward 1 

page  
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Page Thumbnails 

If you activate the Page Thumbnails option, a new panel is opened up on the left-hand side of the 

screen. It contains miniature previews (‘thumbnails’) of each page: 

    

Zoom in / Zoom out 

To rapidly zoom in or out, press CTRL on your keyboard and move the scroll wheel on your mouse: 

  Scroll up  to zoom out, increasing the size of the image 

  Scroll down   to zoom in, decreasing the size of the image 

4.3 eForm completion 

The eForm is an interactive PDF form that contains form fields that are either selected from a 

restricted list or filled in using free text: 

Click inside a text field to enter data. 

Click to select options from e.g. dropdown menus, radio buttons, pop-up calendars and 

checkboxes. 

Press Tab to move forward one field or Shift+Tab to move backward one field. 

Point and click with the mouse to select a specific field. 

 Use the 

thumbnails to 

jump to different 

areas of the form.  

 

 A frame outlined 

in red indicates 

where you are in 

the document. 

 

 Right click on the 

panel to access 

options to enlarge 

or reduce the 

thumbnails.  

Red 

frame 

indicating 

your 

location   
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4.4 Mandatory, optional and calculated fields 

Field Type Characteristics Examples 

Mandatory  

Field label is 

accompanied by an 

asterisk *  

             

Optional Field label has no asterisk 

   

Calculated 

automatically 

Field contains diagonal 

grey lines. 
   

How to highlight mandatory fields 

Click on the purple button  in the navigation panel and this will activate the Document message 

bar which incorporates the Highlight Fields feature. 

 

Mandatory fields –  red border and a light blue background 

Optional fields –  light blue background (and a black border when you hover the cursor over them). 

 

 

        

Please note: if any mandatory field remains incomplete the eForm will not validate successfully and it 

will not be possible to submit your form. 

Once you have activated the highlighting you can click the purple  button again to remove the 

Document message bar (and maximise the display of your form). 

 

Highlighted fields 

Click on the Highlight Fields button and all 

mandatory and optional fields will gain 

highlighting that makes them easier to identify 

(and easier to differentiate from one another). 

Unhighlighted fields 
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4.5 Saving your form 

To save your form, click on the Save button on the toolbar or select Save from the File menu or press 

CTRL and S. 

 

Please ensure that you save your form on a regular basis. If you encounter a problem in your local 

computing environment and your form or your computer crashes, the Adobe Reader auto-recovery 

function will only restore your form to the point of the most recent save. 

4.6 Entering Dates and Numbers 

Please respect the following rules when entering dates and numbers on the form: 

 Rule Example 

Numbers For monetary and percentage values, decimal 

commas and values are permitted. All other 

numbers are whole numbers only. 

- 

Dates Date fields are generally in the format 

dd/mm/yyyy. However, where the year value 

only is requested, this should be provided in 

the format yyyy. 

01/10/2011 for 1st October 

2011 

Telephone numbers No rules -  this is a free text field but please 

provide the country code. 

- 

4.7 Using the Add and Delete buttons (eForm tables) 

Some fields or groups / blocks of fields are required to be completed more than once allowing you to 

build up a 'table' of information e.g. the list of shareholders in Part D.1. Whenever you need to insert a 

new 'blank' field or add rows to a table, you will do this by using the Add buttons. 

These buttons are coloured green. Click on them to add the desired new field or table row. 

 
 

 

 

 

Once you have added a field or row, the delete facility – an orange-coloured button containing an 'x' – 

appears so that you can delete the field, block of fields or table row concerned (and its contents!). 

Please note: some tables are optional but contain fields that are mandatory once a row has been 

added. An example of this can be seen in the screenshot immediately above (Part B.3, table 1). 

 

Click here 

to add a new 

row 

Click here to delete a row 
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4.8 Formatting 

If you enter formatted content into the form e.g. through copy-and-paste from other document sources, 

the eForm will strip off the formatting and plain text only will be pasted into the form. 

Please do not copy bullet points into your form. The formatting of some bullets can trigger the 

requirement to download add-ons to your Adobe Reader software (so that it can handle those bullets). 

4.9 Character Limits 

The free text fields in the eForm have character limits that restrict the amount of text you can enter. 

These limits include both characters AND spaces. If you try to enter more characters than the limit 

allows the form will simply restrict the text to the predefined limit. Many word processing packages 

have a 'count' tool that may help you respect the limits. For other fields, please consult the following 

table: 

Part Field Character Limit 

A 

Full name of the organisation 62 

Full name of the organisation in Latin characters 62 

Acronym 62 

Street 57 

Post code 12 

Town 60 

Internet address 60 

Street 64 

Post code 12 

Town 60 

First name 62 

Family name 62 

Role in the organisation 32 

Email 100 

B 

 

Programme or Initiative 25 

Reference number 40 

Beneficiary organisation 62 

Title of the Project 300 

Programme concerned 60 

C.1 

Title of project 100 

Please specify 62 

Treatment/script language of the submitted version 100 

Production language 100 

Author(s) 100 

Author(s)/Game(play) designer 100 

Director 100 

Director/Project Leader 100 

Other key members of the creative team - Name 100 

Other key members of the creative team - Please specify if role is other 62 

Countries intended for possible co-production 100 

C.3 

Author(s) of concept/subject/treatment/script/literary bible 100 

Treatment/script language of the submitted version 100 

Author(s) of the existing work (literary, audiovisual, comic-strip work etc.) 100 

Title of the existing work 100 
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Part Field Character Limit 

D.1 

Name of Shareholder 100 

Nationality of Shareholder 62 

Main activity if legal person 100 

Name 100 

Nationality 62 

D.2 

Title of the work 100 

Financing plan - Partner Name 100 

Personal experience of (Name) 100 

Name of distributor 50 

Please specify 62 

URL 100 

D.4 

Title 100 

Director 100 

Director/Project leader 100 

Name and nationality of Co-producers 300 

Distribution territories 250 

Selection at Festivals (if any) 500 

Delivery platform 500 

Prizes (if any) 500 

D.5 
Title of the audiovisual related work 100 

Production company of the audiovisual related work 100 

E.4 
Project title 100 

Specify which training has been followed 100 
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5 Guidance for specific Parts of the form 

5.1 Cover Page 

 

Important! 

Fill in the fields of the Cover Page first! 

Please ensure that you complete all the fields of the Cover Page (page 1) before going on to 

complete the rest of the form. This is because the selections that you make, dictate how the rest 

of the form appears and behaves. 

If, after filling in parts of your form, you change your choice of Action / Sub-action – or even 

just re-select the same Action / Sub-action from the dropdown menu – you will lose data that 

you have entered elsewhere in the form.  

Deadlines for submission (Rounds) 

Please be aware of the following constraints:  

 Applications may only be submitted for the next scheduled deadline – the online system 

blocks the submission of applications that are for a deadline that is not the next scheduled 

deadline. 

 Once a deadline has passed, there is a gap in time before the online submission system is 

re-opened for the next scheduled deadline. Here are the details of when the online 

submission system is opened for each deadline: 

o Round 1 deadline 23/11/2012 Submission opened when the eForm was published; 

o Round 2 deadline 12/04/2013 Submission open from 01/01/2013. 

 If you attempt the submission having selected the deadline that is not the next scheduled 

deadline OR when the online submission system is closed, the submission of your form 

will be blocked and it will not take place. Nevertheless, it will still be possible for you to 

submit that same form once the submission has been opened. Be aware, however, that the 

submission process will have locked your form so you will no longer be able to modify 

its content or change the attachments. 

 It is not possible to submit an application for a deadline that has already passed. The 

online system blocks such submission attempts. 

If you have attempted the submission for a deadline that has passed, it will not be possible to 

correct the deadline value (and resubmit) because the form will be locked. You would therefore 

be obliged to start your application again with a new form 

 

5.2 Part A – Identification of the applicant and other organisations participating in the project 

 The field ‘Internet address’ in Part A.1 relates to the organisation’s website address. 

 The Registered address you enter in Part A.1 is automatically copied to Parts A.2 and A.3. 

Check the relevant checkbox in order to write different address details in Parts A.2 or A.3. 

 Please ensure you have filled in all the Applicant Organisation details before going on to 

complete the rest of the form. This is because the forms adapts according to the ‘Country’ 

value that you have selected. 
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5.3 Part C – Description of the project 

The number of projects required to be recorded varies according to the Action and Sub-action you 

selected on the Cover Page. Where there is a minimum number of projects associated with an Action 

and Sub-action, the form automatically generates all the necessary project fields for you to complete. 

If you subsequently add further projects (where this is applicable) and then decide to delete one of 

them, the form automatically re-numbers the remaining projects so that the numbering remains 

sequential. 

Slate Funding/Slate Funding 2nd stage applications ONLY 

The fields C.1, C.2 and C.3 are repeated for every project that you record in Part C of the form. 

Moreover, for each of these projects in Part C, a corresponding Part E.1, E.2 and E.3 is automatically 

generated in the form for you to complete. 

If you delete a project in Part C.1/C.2/C.3 of the form – which becomes possible if you have recorded 

more than three projects – the corresponding fields in Part E.1/E.2/E.3 are also deleted. 

Single Project applications ONLY 

The project title you enter in Part C.1 is automatically copied to Part E.1 

5.4 Part D – Technical capacity 

In this Part, you may be required to enter a list of projects (D.2) and work items (D.4). The numbering 

for these projects and work items is generated automatically by the form. If you delete one of the items 

you have entered, the form automatically re-numbers the remaining items so that the numbering 

remains sequential. 

5.5 Part E – Project implementation / award criteria 

See section 5.3 above for details of the synchronisation between Part E and Part C of the form. 
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6 Attaching Documents to your eForm 

The following mandatory annexes, which are a formal part of your grant application, must be attached 

to your eForm: 

 Detailed description of the project; 

 Development Budget. 

Please respect the following filenames and formats for your attachments: 

Annex Required Filename Required Format 

Description 

of Project 
Devt_ISO country code_company name_ProjDesc .pdf or .doc or 

.docx 

Development 

Budget 
Devt_ISO country code_company name_Budget .xls or .xlsx 

 

Attachment size limitation 

There is a limit to the total (combined) size of your attachments. This is 5MB. If you receive a 

message advising you that the total size of documents exceeds the maximum allowed, please reduce 

the size of any image-based document e.g. by reducing its resolution. 

If your Detailed description of the project is a Microsoft Word document and contains images, this 

may result in a large-sized document. This in turn could result in your attachments exceeding the 5MB 

limit. If this happens, you can reduce the size of the document by converting it from Microsoft Word 

to pdf format. 

Example filename 

For a company called Bestco based in Belgium, the budget annex would be named: 

  Devt_BE_Bestco_Budget 

(This example filename does not include the extension details – .xls or .xlsx) 

To carry out the attach function, click on the relevant Attach a document button and a window will 

pop up enabling you to browse, locate and select the file you wish to attach: 

 

 

 

 

Click on the ‘Open’ button to 

attach the selected file to your 

application. 
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Once a file has been successfully attached, the filename is displayed and the Attach a document  

button is replaced by a Delete this document button and a View this document button: 

 

Viewing attached documents 

You may encounter the following information message when trying to view non-PDF documents that 

you have attached: 

       

If so, you can change your settings – to allow such documents to be opened – via the following Adobe 

Reader menu path: 

 Edit > Preferences > Trust Manager 

Check the box Allow opening of non-PDF file attachments with external applications and then click 

OK to confirm the setting change: 

    . 
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7 Validation of your eForm 

The Validate Form button appears at the bottom right of every page of the form.  

 

(It is recommended that you do not validate your form until you have finished completing it as 

validation slightly alters the look of the form. It also uses up computer memory, so it is best not to 

validate if you know that you still have a significant number of mandatory fields to complete.) 

When you are ready, click on the button and various checks will be automatically performed to 

ascertain whether your form is ready for submission. For example, the validation will verify that all 

mandatory fields have been completed and that all the mandatory attachments are present. 

If there are any errors present, the total number of them will be listed on the last page of your form. If 

there are any budget or attachment errors these will be itemised separately in the same list:  

 

The errors themselves will be highlighted in pink. In the example that follows the mandatory field 

Summary of the project has not been completed: 

 

 

 

 

 

Clicking the button validates the whole 

form, not just the page you are on. 
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When you validate, an additional button – the Go to next error button – appears next to the Validate 

form button.  

 

Use this button to jump from error to error in your form. The function starts with the error nearest the 

top of the form i.e. nearest to Page 1 and descends the form moving to the next error with each click. 

Please note the following: 

 When you fix the errors that are highlighted, the Errors list is not dynamically updated. It is 

only updated i.e. refreshed when you perform another validation. 

 The Go to next error function works best when you fix errors one by one, following the top-

to-bottom sequence used by the Go to next error button. If you fix errors out of sequence e.g. 

fix an error further down the form, the Go to next error function will still follow the original 

sequence of errors reported by the validation.  

 If you have fixed errors out of sequence, you are recommended to perform a fresh validation 

so that the errors you have fixed are removed from the sequence (and you would then start 

again from the error nearest the top of the form). 

 If you prefer, you can simply do a visual search for the pink errors in your form. If you do 

this, it is recommended that you first turn off the highlighting for mandatory fields (see 

Section 4.4). You may find the thumbnail view a useful aid to quickly detecting the pink 

highlighted fields (see Section 4.2). 

Whichever method you use, fix the errors that are present and validate your form again. If all errors 

have been resolved you will see the following pop-up message: 

 

Until your form validates successfully the Submit button is disabled and it will not be possible to 

submit your form. The Submit button turns from grey to green when validation has been carried out 

successfully. 
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8 Submission of your eForm 

On the final page of the form is the Submit this form button. Once your form has been successfully 

validated the button is enabled (as confirmed by its green colour). Click on this button to launch the 

submission.  

 

The following message will appear: 

 

If for any reason you do not want to continue, you may click No and carry out the submission at a later 

time. The submission process will end. Once you click Yes your form will be locked and it will no 

longer be possible to modify its content or change the attachments. 

8.1 The mandatory save BEFORE submission 

If you click Yes, the next step of the submission process is a mandatory save. The following message 

appears: 

 

When you click OK, the form triggers a Save As operation. You will see the classic Save As window as 

appears in the screenshot which follows.  

(Please note: this screenshot is simply an example of the Save As window. The window that you see, 

will reflect the filename and directory name that you have been using.)  
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You must now perform the Save As by clicking on the Save button. 

Very Important! 

You must NOT change the filename of your eForm. 

You must keep the same filename that the file had when you began the submission operation!  

Click Yes when you are asked if you want to replace the existing file: 

 

8.2 Submission 

Depending upon your security settings, the following pop-up window may now appear: 

 

 

Example screenshot 
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If the window appears, click on the Allow button in order to proceed with the submission. 

When the submission is complete you will see a pop-up message similar to the one that follows: 

       

Click ‘OK’. 

8.3 The mandatory save AFTER submission 

When you click OK, the form triggers another Save As operation. This is so that you cannot 

mistakenly close the form without saving (and so lose the submission number).  

Once again you will see the classic Save As window appear: 

      

You must now perform the Save As by clicking on the Save button. 

Very Important! 

You must NOT change the filename of your eForm. 

You must keep the same filename that the file had when you began the submission operation!  

 

Example screenshot 
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Click Yes when you are asked if you want to replace the existing file: 

 

When you click ‘Yes’, the submission number is automatically added to the ‘Submission number’ 

box:  

 

It is also inserted into the footer of your form. 

The form has also been saved and this save included the submission number. 

Your submitted form is now ‘locked’. That is to say, it has been converted to a read-only document: 

changes cannot be made to it and it cannot be re-submitted.  

As part of the submission process, an email message acknowledging receipt of your eForm is 

automatically sent to the email address you entered for the contact person of the Applicant 

Organisation (Part A.2).  

As instructed by the earlier pop-up message, you should now print the form before closing it. 

Please consult the Guidelines for details of how to submit the paper version of your eForm. 

9 Printing your eForm  

The eForm can be printed using Adobe Reader’s standard menu-driven print function. The Print 

button is found on the tool bar, or the Print menu can be selected from the File menu.  

 

10 How to obtain technical assistance – EACEA Technical HelpDesk 

If this User Guide does not provide answers to all of the technical questions or problems you 

encounter in completing the application form, a telephone and email HelpDesk service is available to 

assist you further: 

EACEA Technical HelpDesk: +32 229 90705 

eacea-helpdesk@ec.europa.eu 

Monday to Thursday 09:30 to 17:30 

Fridays 09:30 to 17:00 

Excluding public holidays 

All times are Brussels time 
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Please note that where the deadline for submission of applications falls on a weekend or Belgian 

public holiday no HelpDesk support will be available.  

You may also visit the Agency’s dedicated eForm webpage which contains the latest versions of all 

published forms along with a Test eForm and other items of information: 

 http://eacea.ec.europa.eu/eforms/index_en.php 

Non-technical assistance 

If you require assistance with a query or problem that is not technical in nature, please do not contact 

the EACEA Technical Helpdesk. This Helpdesk team are only authorised and trained to help 

applicants who are encountering technical problems. 

Please refer instead to the funding opportunities webpage of the programme/action that you are 

applying for. On this webpage you will find details of how to obtain non-technical assistance e.g. 

assistance with questions on: 

 the content of the eForm; 

 the application process including instructions for providing the backup copy; 

 the rules of the programme / Call that you are applying for. 

Generally speaking, the funding opportunity webpage will include the mailbox address of the 

programme team that is responsible for the programme/action that you are applying for. The page will 

also contain documentation that may already provide an answer to your non-technical question e.g. a 

Programme Guide or Guidelines document or a link to an in-country Helpdesk which can help you. If 

you cannot find the answer to your question, please contact the mailbox of the programme team cited 

on the funding opportunities webpage. 

The following table provides some examples of technical and non-technical questions. 

Technical Questions 

(handled by the EACEA Technical Helpdesk) 

Non-technical Questions 

(handled by an in-country MEDIA Desk or by 

the programme team) 

I can’t download the form. 
What is required to be entered for the field Other 

Community Grants? 

A dropdown list isn’t working. Why isn’t country A in the dropdown list? 

I can’t attach my budget form (or 

other annexe/attachment). 
I need help with completing my budget form. 

How does the synchronisation of fields work? Why is this field mandatory? 

I can’t delete a table row that I have entered. 

Our project has more than one coordinator. 

What should I do? 

What is the minimum / maximum number of 

partners that is allowed? 

My form freezes/crashes. 
What documents are required for the paper 

backup and where do I send it? 

My form is working slowly. I need more characters for my answer! 

My form won’t validate. What do you mean by the term ‘acronym’? 

My form won’t submit. 
Where are the templates for the attachments and 

additional documents? 

I think there is a bug in the form. 
What should I enter in the form for my project start 

and end dates? 

 

http://eacea.ec.europa.eu/eforms/index_en.php

